
 

 

 

LAB 1: FUNDAMENTELE SIMULARII UNUI CIRCUIT 

 

 

 

 

 

 

Obiective: 

 Crearea unui nou proiect 

 Crearea unui schematic design 

 Setari si efectuari de simulari cu S- parameter 

 Afisarea datelor rezultate in urma simularii si salvarea acestora 

 Varierea parametrilor din circuit in timpul simularii 

 Folosirea fisierelor Exemplu si numele nodurilor 

 Executarea unei simulari Harmonic Balance 

 Scrierea ecuatiilor in data display 

 

 

 

 

 

(Name Removed) 

(Name Removed) 

Grupa: 55RD 

 

 



PROCEDURA: 

 

1. Deschideti  ADS pe calculator. 

a) Apasati pe scurtatura pentru ADS daca apare pe ecran sau 

folositi Start  Programs pentru a gasi si a deschide 

Advanced Design System ca in imagine. 

 

 

 

 

 

 

 

 

b) Cand apare fereastra principala, ar trebui sa vedeti si fereastra Getting Started. Daca aceasta 

apare, inchideti-o.  

 



2. Examinati preferintele din 

fereastra principala. 

a). In fereastra principala, 

apasati Option  Preferences. 

 

 

 

b). Cand fereastra Main Preference apare, asigurati-va ca nu sunt dezactivati parametrii din 

imagine. Nu avem nevoie de ei in acest curs. 

 

 

 

 

 

 

 

 

 

 

c). Asigurati-va ca este bifata optiunea 

Large Toolbar Bitmap si lasati celelalte 

optiuni asa cum sunt In mod implicit. 

 

 

 

 

d).   Apasati OK. 

 

 



3. Creati un nou proiect. 

Pentru acest pas se vor folosi butoanele din fereastra principala. Folosirea acestor butoane 

necesita mai putine click-uri de mouse. Butoanele se pot identifica plasand cursorul mouse-ului 

deasupra fiecarui buton pentru a afisa un mesaj. 

a). In fereastra principala alegeti View  Startup Directory. Aceasta va arata ca sunteti in 

directorul implicit pentru proiecte ADS. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b). Apasati : File  New Workspace sau folositi butonul aratat in imaginea de mai sus. 

 

 

 



Cand apare fereastra de 

dialog, veti vedea cateva 

informatii despre ceea ce 

contine un workspace. 

Apasati Next. 

 

 

 

 

 

 

 

 

Dati un nume workspace-

ului si alegeti calea unde 

acesta va fi creat. Apasati 

next. 

 

 

 

 

 

 

 

 

 

 



Selectati librariile ca in 

imagine. 

 

 

 

 

 

 

 

 

 

Denumiti libraria 

dumneavoastra care se va 

salva in workspace-ul creat 

mai sus. 

 

 

 

 

 

 

 

 

 

 

 

 



Selectati tehnologia pentru noua 

biblioteca. 

 

 

 

 

 

 

 

 

 

 

Apasati Finish. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4. Examinati fisierele din noul folder. 

a) Uitati-va la fereastra principala la tab-ul File View. Acum va arata fisierele care sunt create 

automat in workspace-ul MyWorkspace_wrk. 

 

 

 

 

 

 

 

 

 

b) Uitati-va in Folder View si observati ca proiectul este gol in acest moment - nu exista niciun 

schematic sau date. 

 

 

 

 

 

 

 

 

c) De asemenea, observati ca butoanele de schematic, layout si si date afisate sunt activate(nu gri). 

Aceasta inseamna ca acum puteti deschide aceste ferestre, ceea ce vom face in urmatorii pasi. 

 

 

 

 

 

 

 

 



5. Crearea unui filtru trece jos. 

a). In fereastra principala, apasati butonul New schematic Window sau selectati File  New 

Schematic. Imediat, fereastra Schematic va aparea. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b). Dati o denumire celulei dumneavoastra si apasati 

OK pentru a salva. 

 

 

 

 

 

 



c). Examinati comenzile si butoanele din aceastra fereastra Schematic. Apasati pe sageata de la 

lista de palete cu component pentru a vedea ce alegeri puteti face. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



d). In paleta cu Lumped 

Components, selectati (click) 

condensatorul C ca in poza (nu C 

model). Apoi apasati butonul  Rotate By 

Increment asa cum aveti nevoie pentru a 

avea o o orientare corecta a 

condensatorului si apoi apasati pe 

schematic pentru a insera condensatorul 

cum este arata in imagine. Apoi inserati 

alt condensator. 

Nota: puteti schimba culoarea de 

background a schematic-ului, punctele de 

grid sau mai multe utilizand Options  

Preferences. 

 

e). Continuati sa creati filtrul trece jos inserand bobina si masa (dupa 

cum se arata si in poza alaturata). 

f). Dupa ce ati terminat de pus componentele, editati valoarea lui C2 

in 3 pF. Pentru aceasta, faceti dublu-click pe simbolul condensatorului sau 

selectati condensatorul si apasati pe butonul din poza R=17. Cand apare 

fereastra de dialog, schimbati valoarea: C=3.0 pF, apasati Apply si OK. 

 

 

g). Selectati paleta Simulation- S_Param si inserati controller-ul 

pentru simulare: S-parameter. Apasati ESC pentru a termina aceasta comanda. 

 

 

 

 

 

 



h). Inserati terminalele portului: Term Num=1 si Term num=2. 

i). Folositi istoricul componentelor: Dupa ce ati facut circuitul, stergeti condensatorul C2 si apoi 

reinserati-l scriind sau selectand din istoric litera C si apasati Enter. Apoi editati valoarea direct pe 

schematic (3.0pF). Verificati ca aceasta s-a schimbat uitandu-va la valoarea din fereastra de editare. 

 

 

 

 

 

 

 

 

6. Setarea pentru simulare a lui S-parameter. 

 

a). Pentru a seta simularea, faceti dublu click pe controller-ul 

pentru simulare S-parameter din schematic. Cand apare 

fereastra de dialog, schimbati Step-size in 0.5 GHz si apasati 

Apply. Observati cum I se schimba valoarea pe ecran. 

Butonul OK face acelasi lucru ca si Apply dar acesta inchide 

si fereastra de dialog – nu apasati OK inca. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

b). Apasati pe tab-ul Display si veti vedea valorile pentru Start, 

Stop si Step sunt bifate implicit pentru a fi vizualizate pe schematic. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c). Apasati OK pentru a disparea fereastra de dialog. Acum se poate face simularea. 

 

 

7. Lansati simularea si afisati datele. 

 

a). Deasupra ferestrei cu schematic, apasati pe butonul Simulate aratat ca in poza 

pentru a da start procesului de simulare. 

 

b). Uitati-va la fereastra cu Statusul simularii si ar trebui sa vedeti mesaje similar 

cu cele afisate in poza, descriind rezultatele simularii, scrierea in fisierul cu date. 

 



 

Daca nu au aparut erori de simulare, inchideti fereastra cu Statusul simularii. Puteti mereu deschide 

aceasta fereastra folosind comanda Window  Simulation Status (puteti incerca). 

c). Fereastra cu Data Display va aparea cu numele cell_1 in coltul din stanga sus. 

 

 

 

 

 

 

 

 

 

 

 

 

d). Pentru a crea un grafic, apasati pe butonul Rectangular Plot si mutati cursorul in fereastra si faceti 

click. Cand apare urmatoarea fereastra de dialog, selectati S(2,1) si apasati pe butonul Add. Apoi selectati 

dB ca si format pentru aceasta data. Apasati butonul OK. 

 

 

 

 

 

 

 

 



 

Graficul ar trebui sa arate un raspuns al filtru trece banda rezonabil. Daca aveti o rotita a mouse-ului – 

incercati sa o folositi marind si micsorand graficul. 

e). Puneti un marker pe forma de unda: Apasati pe butonul new marker din bara de sus cum se arata in 

imagine. Va trebui sa alegeti forma de unda pe care doriti sa inserati markerul. Incercati sa folositi si 

celelalte butoane pentru markere. De asemenea, puteti muta marker-ul folosind cursorul mouse-ului sau 

sagetile de pe tastatura. Incercati sa stergeti marker-ul si sa adaugati altul pe forma de unda. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



8. Salvati aceasta fereastra Data Display. 

a). Salvati aceasta fereastra Data Display: Folositi comanda File  Save As si folositi urmatoarea 

fereastra de dialog pentru a salva cu numele implicit cell_1.  Aceasta inseamna ca se va salva ca fisier 

.dds in fisierul MyWorkspace_wrk si va avea acces la toate datele in directorul data. Acest pas va arata ca 

se va salva in directorul cu workspace si nu in cel de date. Doar datasets sunt salvate in fisierul data. 

b. Inchideti fereastra de afisare a datelor folosind: File > Close. 

 

 

 

c. Redeschideti fereastra cu datele salvate dand click pe iconita  Data  Display  din fereastra Schematic 

sau Main. Dupa ce s-a deschis  fereastra, dati click pe iconita Open pentru a deschide fisierul. 

Selectaticell_1.dds din dialog si dati click pe Open. Va reapărea  graficul S21. De asemenea, observati ca 

in mod implicit numele setului de date (cell_1) va ramane acelasi de la simularea precedenta. Tineti 

fereastra deschisa pentru pasii urmatori. 



 

 

 9. Reglati circuitul de filtrare 

Acest pas introduce optiunea ce permite sa reglati valorile parametrilor componentelor si sa vedeti 

rezultatele simularii in fereastra de afisare a datelor. Daca mai intai selectati caracteristica de reglare, 

trebuie sa selectati parametrii componentelor si nu componentele. 

a. Pozitionati ferestrele Data Display si Schematic pentru a le putea vedea pe ambele simultan. Daca e 

necesar, reglati marimea ferestrelor si folositiView All. 

 

b. Acum, porniti tuner-ul dand click pe comanda : Simulate>Tuning sau dati click pe iconita 

TuneParameters.  

 

 

c. Imediat, fereastra cu statusul simularii va aparea impreuna cu fereastra TuneControl.  Dati click pe 

parametrul C al condensatorului C1. Parametrul reglabil va aparea in Tune Controller , parametrul va 

aparea cu {t} pentru a arata ca permite  reglarea. O alta modalitate de a selecta parametrul va fi prezentata 

in continuare. 



 

 

 

 

 

 

 

 

 

 



d. Dati click pe simbolul bobinei si va aparea o fereastra de dialog, dati click pe L si apoi pe OK. Astfel 

se va adauga bobina in controlerul de reglaj.   

 

e. Aranjati fereastra de afisare a datelor si graficul S-21 astfel incat sa puteti vedea si tuner-ul si graficul. 

Puneti un marker in punctul 5GHz (asa cum este aratat in imagine). Incercati sa mutati cursoarele tuner-

ului si observati cum graficul este automat modificat, ca si cum ati regla graficul cu un  instrument. 

 

 

 

 

 



f. Cresteti valoarea Max panala 6pentru ambii parametri si continuati sa reglati pentru a avea un raspuns 

FTJ tipic : de aproximativ -3 dB aproape de 2GHz (pentru a vedea aceasta deplasati marker-ul la 2 GHz 

cum este aratat in imagine).

g. Salvati graficul dand click pe butonul Store si apoi pe OK. Deplasati cursoarele tuner-ului – graficul 

salvat ramane ( linia punctata) in timp ce graficul nou se  modifica. Graficele pot fi salvate/redeschise si 

facute vizibile atunci cand este nevoie. 

 



 

h. Folositi butonul Close de pe tuner  pentru a-l inchide . Salvati  afisajul cu date si schematicul folosind 

iconita Save. Inchideti toate ferestrele cu exceptia ferestrei principale  ADS. In continuare vetivaria 

armonicele (Harmonic Balance)intr-un exemplu ADS. 

 

NOTA IMPORTANTA: Folosind exemplele ADS 

Toate exemplele ADS se afla in directorul Examples. Pentru a fi folosite ,exemplele trebuie copiate in alt 

director. In general directorul Examples este read-only si trebuie sa ramana nemodificat. 



 10. Copiati un exemplu de RFIC Harmonic Balance(variere a armonicelor). 

a. Mergeti la fereastra principala  ADS si dati click pe iconita View Example Directory pentru a vedea 

lista cu exemple. Daticlick pe iconita View Current Working Directory pentru a vedea daca sunteti in 

workspace-ul creat. 

 

b. Selectati fisierul amplifier_wrk.7zads de la calea<….  KeysightADS2016_01 RFIC> si dati 

click pe Open. 

 



c. Dati click pe  fereastra Library View pentru a deschide HBtest.  

 

Acesta este cel mai inalt nivel din ierarhie al HBtest, aici se seteaza simularea Harmonic Balance. Pentru 

a vedea subcircuitul amplificatorului dati click pe simbolul amplificatorului si apoi dati click pe iconita: 

Push into Hierarchy. 

 



d. Observati ca subcircuitul are cateva dispozitive divizate ce au descrierea modelului. Dati click pe Pop 

Out of Hierarchy pentru a reveni la nivelul cel mai inalt al ierarhiei ,unde se seteaza simularea. 

 

 

 

 

 

 

 

 

 

 

 

 



e. Examinati controlerul de variere a armonicelor (Harmonic Balance) dand dublu click pe el sau 

selectandu-l si apoi  dand click pe iconita de editare. 

 

 

 

f. Controlerul de variere a armonicelor (Harmonic Balance) are multe campuri pentru setarea parametrilor 

simularii. Examinati  campurile fara a face vreo schimbare si dati click pe Cancel. 

 
 

 

 

 

 



 11. Adaugati o eticheta (numele nodului) si simulati. 

a. Dati click pe iconita Name. Cand apare fereastra de dialog scrieti numele Vin si dati click pe firul sau 

nodul de la intrarea amplificatorului si apoi dati click pe Close . Schematicul acum va avea o eticheta Vin 

si una Vout. 

 
 

b. Dati  click pe  iconita Simulate. Cand simularea se termina, tensiunile  de nod de la Vin si Vout vor fi 

disponibile in fereastra de afisare  de date (DataDisplay).   

 

 
 

 

 

 

 12. Schitati spectrul lui Vout in dBm. 

 

a. Cand fereastra de afisare  de date (Data Display) se deschide, selectati graficul rectangular 

(Rectangular Plot) si inserati-l. Imediat va aparea alta fereastra in care selectatiVout si dati click pe 

Add. Alegeti formatul Spectrum in dBm. Dati click pe OK si apoi peOK din nou ca sa apara  

graficul. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



b.  Puneti un marker pe prima armonica pentru a verifica ca sunt 960 MHz. 

 

 
 

c. Inserati o ecuatie selectand iconita Eqn si inserati-o in fereastra de afisare a datelor. Imediat va aparea 

o alta fereastra de dialog. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



d. Scrieti ecuatia  cu o greseala in scrierea numelui nodului. De exemplu, scrieti o ecuatie pentru castig : 

Gain=Vout/Vn. Dati click pe Apply ca sa vedeti cum este recunoscuta eroarea. 

 

 
 

e. Corectati ecuatia scriind Vin in loc de Vn. Dati click pe Apply si OK. Ecuatia corecta va aparea. 

 
 

NOTA pentru afisarea ecuatiilor de date: Daca ecuatia apare de culoare rosie inseamna ca este 

invalida. 

 

 

 

 

 

 

 

 

 

 



f. Pentru a lista valoarea ecuatiei Gain, inserati o lista selectand iconita List. Cand apare fereastra de 

dialog apasati pe sageata si derulati pana la Equation. Atunci cand apare selectati ecuatia Gain, dati click 

pe Add si apoi pe OK. 

 
 

Trebuie sa vedeti o lista de castiguri: tensiunile complexe pentru fiecare frecventa calculate de catre 

ecuatie. De fapt, acest circuit are un castig in curent mai mare decat cel in tensiune. 

 

 
g. Inchideti toate ferestrele. Nu salvati modificarile. 

 

 

 

 

 13. Examinati fereastra principala. 

 

a. Observati butonul Library View din fereastra principal care ne arata design-urile si afisajele de date. 

 

 

b.  Orice design sau afisaj de date poate fi redeschis dand dublu click pe el. Pentru a-l inchide dati click 

pe : File > Close Workspace. 



 
 

EXERCITII EXTRA:  

1. Incercati sa cautati un exemplu de acpr folosind iconita Example Search. 

 
2. Intorceti-va la simularea HBtest si cresteti ordinul in simulatorul de variere a armonicelor 

(Harmonic Balance) pana la 7. Simulati inca o data si observati ce se intampla. Schimbati 

valoarea frecventei (Freq) pana la 940 si observati ce se intampla- puteti invata despre erorile de 

simulare dintr-un asa tip de exercitiu. 

3. Scrieti alta ecuatie pentru aceste rezultate  ale lui  HBtest. 

                                    Gain_fund = Vout[1] / Vin[1]  

Determinati ce rol are valoarea din paranteze [1]. 

4. Intoarceti-va  la design-ul LPF si deschidetipagina de afisare de date. Incercati sa scrieti o ecuatie 

pentru faza lui S21 si apoi afisati-o. 

 

 
5. Examinati alte exemple care vi se par interesante. 

 



 

LAB 2: Proiectarea Sistemelor Fundamentale 

 

Prezentare generală: Acest capitol ne introduce în câmpul de utilizare a modelelor comportamentale 

pentru a crea un sistem cu funcția de receptor. Acest laborator va fi primul pas în procesul de 

proiectare unde nivelul sistemului al modelelor comportamentale sunt simulate să aproximeze 

performanțele dorite. Având în vedere că putem seta specificațiile dorite ale componentelor 

sistemului, ne permite mai târziu înlocuirea lor cu circuite individuale și compararea rezultatelor cu 

cele ale modelelor comportamentale. 

  

OBIECTIVE: 

 Alicarea deprinderilor dobandite in primul laborator. 

 Crearea unui proiect a unui sistem pentru un receptor RF utilizand modele comportamentale 

(fitre, amplificatoare, mixere) unde: RF = 1900 MHz si IF = 100 MHz. 

 Utilizarea unei surse RF, unei LO cu zgomot de faza si a unui controler de zgomot. 

 Testarea sistemului: S-parameters, Spectru, Zgomot, etc. 
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1. Crearea unui proiect nou (system) și a unui schematic 

 Fereastra principală a programului - Advanced Design System 2016.01 (Main) permite 

gestionarea proiectelor (creare, stergere, arhivare, etc.). Fiecare proiect va fi stocat intr-un director 

propriu cu numele “nume ales” + “_wrk”, implicit în directorul de instalare “C:\Users\Anamaria 

Rosca\” dar calea poate fi modificată (şi cea implicită, de instalare, şi individual la crearea unui proiect 

nou). 

 

 

a) Pentru a crea un proiect nou folosim comanda: File >  New > Workspace
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 În fereastra care apare se introduce numele dorit al proiectului după calea deja afişată 

“C:\Users\Anamaria Rosca\”. Numele noului proiect: system. 

 

 

b) În fereastra cu noul proiect se creează și schematicul cu numele  rf_sys, astfel: File >  New > 

Schematic. 
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2. Proiectarea unui sistem de recepție cu comportament RF 

 

a. În paleta de componente selectăm Filters-Bandpass și alegem Butterworth filter. 

 

 

 

 Setați parametrii filtrului astfel:  

  Fcenter= 1.9 GHz – reprezintă frecvența purtătoarei 

  BWpass = 200 MHz 

  BWstop = 1 GHz 

 

b. În paleta de componente selectăm System‐Amps & Mixers și alegem Amp. 

 

 

 

  

 

 

 

 Se setează parametrii amplificatorului astfel: 

  S21 = dbpolar (10,180). 

 

c. În paleta de componente selectăm Simulation-S_Param și alegem componenta 

Term.  
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 Notă: Butterworth filter – pentru filtrul Butterworth răspunsul este ideal, așadar nu 

există în banda de trecere nici un riplu. După ce filtrul și amplificatorul sunt înlocuite cu modelele de 

circuit, va apărea și riplul. Pentru modelarea filtrului cu riplu se va utiliza un filtru cu comportament 

eliptic. 

 În continuare vom adăuga la sistemul RF un LO (Local Oscillator) și un mixer 

comportamental. 

d. În paleta de componente selectăm System‐Amps & Mixers, alegem componenta 

Mixer și o plasăm la ieșirea amplificatorului.  

Atenție! NU confundați Mixer cu Mixer2. Mixer2 este similar, și de asemenea pentru 

analiza non-lineară, dar nu este compatibil cu caracteristica de conversie a frecvenței 

semnalului mic al analizei parametrilor S care se vor folosi in acest exercițiu. 

  

e. Pentru componenta Mixer se setează parametrii astfel: 

ConvGain = dbpolar(3,0) 

SideBand = LOWER 

Variantele pentru SideBand se pot modifica plasând cursorul în dreptul lui si folosind 

tastele UP și DOWN.  Pentru ceilalți parametrii se vor pastra parametrii impliciți. 

Pentru editarea pe ecran, 

utilizati tasta ENTER 

pentru a trece la editarea 

urmatorului parametru. 
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f. Pentru a muta parametrii caracteristici fiecărei componente, apăsăm tasta F5 după 

care se selectează componenta în cauză. Optam pentru aceasta varianta pentru a 

diferentia clar componentele.  

 

g. Adăugam un LO (Local Oscillator) introducând o rezistență de 50 ohm din paleta 

Lumped-Components,  în serie cu o sursă de tensiune V_1Tone din paleta Sources-

Freq Domain. Se setează frecvența sursei de tensiune la 1.8 GHz. Acesta va furniza la 

ieșire o frecvență intermediară de 100 MHz. NU uitați masa(ground)! 

 

 

 

 

 

 

Local Oscillator: rezistenta, o sursa 

de tensiune si masa. 
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h. Adăugați un filtru Bessel trece jos la ieșirea compunentei Mixer, din paleta Filters-

Lowpass. Setați parametrul parametrul Fpass = 200 MHz. 

 

i. La ieșirea circuitului inserați componenta Term din paleta Simulation-S_Param. 

 

Circuitul final ar trebui să arate ca în figura următoare: 

 

 

NOTĂ: Puteți seta parametrul N (ordinea) al filtrelor, dar nu este necesar. În mod implicit, ADS va 

calcula ordinea (N) bazată pe specificații. Dacă parametrul N este specificat, ADS va folosi valoarea 

introdusă. 

 

3. Setarea simulării parametrului S cu conversie de frecvență. 

 

a. Pentru a indica simularea pentru schema, trebuie introdus un controler de simulare 

SP din paleta Simulation-S_Param și configurați simularea în banda 1-3 GHz cu pasul 

de 100  MHz. 

 
 

b. În căsuța de editare, deschisă prin dublu click pe controlerul S-PARAMETERS, bifăm 

Enable AC frequency frequency conversion.  
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c. În tab-ul Display bifăm FreqConversion și FreqConversionPort. Portul 1 este, în mod 

implicit, portul unde frecvențele voi fi convertite folosind de asemenea si setările 

mixerului. 

NOTĂ: această conversie este valabilă doar pentru acest mixer. 
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Controlerul de simulare S-Parameter ar trebui să arate ca în figura următoare: 

 

 

d. Comanda din meniul Simulate > Simulation Settings…  va deschide fereastra de unde 

putem modifica numele implicit Dataset, debifăm Use cell name și redenumim 

rf_sys_10dB pentru a indica simularea unui sistem cu un câștig 10dB, apoi selectăm 

Apply. 

 

e. Pentru simularea efectivă puteți folosi  , F7 sau comanda din meniul Simulate > 

Simulate.  
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4. Reprezentarea grafică a date S21. 

 

a. În fereastra care apare, inserăm: Rectangular Plot din partea stânga a ferestrei. 

 

 

 

 

 

 

 

 

 

 

 

 Pentru a afișa S(2,1) trebuie să selectăm dB(S(2,1)) ca în figura de mai jos și OK. 
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Graficul rezultat va fi următorul: 

 

 

b. Plasăm un marker pe grafic în apropierea frecvenței 1.9GHz. 

 

În casuța aferentă marker-ului, introducem pentru valoarea frecvenței 1.9 GHz
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 Valoarea câștigului este determinata astfel: din valoarea câștigului de conversie al mixerului 

scadem pierderile datorate nepotrivirilor. 

 

5. Creșterea câștigului, simularea și adăugarea unei noi forme de undă. 

 

a. În schema principală valoare câștigului amplificatorului se va modifica de la 10 la 20 

dB. 

 

 

b. Selectăm Simulate -> Simulation Settings… schimbăm numele atribuit dataset-ului 

din rf_sys_10dB în rf_sys_20dB. Apăsăm Apply, după care Simulate (F7). 
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c. Când simularea este gata, va apărea o căsuță care vă intreabă dacă doriți să 

modificați dataset-ul implicit. Răspundeți cu: No.  

 

 

 

 

  

 

 

 

d. Editați graficul existent (dublu-click), cel cu forma de undă pentru 10dB, selectând în 

câmpul Datasets and Equations dataset-ul rf_sys_20dB. 

 

e. Selectați S(2,1) și adăugați în câmpul Traces valoarea în dB. Observati ca este 

mentionata intrega cale deoarece nu face parte din datele implicite. 
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f. Adăugați câte un marker de tip Max Marker pe fiecare formă de undă, după care 

selectați marker-ul aferent formei de undă pentru 20dB și selectați în câmpul Marker 

Mode -> Delta, pentru a vedea diferența de 10dB dintre cele două simulări.  

Asigurați-vă că salvați toate datele! 
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6. Setarea unei surse RF și a unei surse LO cu zgomot de fază. 

 Pentru această etapă vom învăța cum să simulăm zgomotul de fază introdus de 

comportamentul oscilatorului, utilizând simularea de tip Harmonic Balance. La aceasta etapa nu este 

necesara cunoasterea tuturor parametrilor utilizati pentru simularea de tip Harmonic Balance. Ne 

vom ocupa de acest lucru mai tarziu. 

a. Salvați schematicul curent  sub numele:  rf_sys_phnoise din File -> Save As… 

 

b. În circuitul salvat, stergeți următoarele componente: S_param, sursa LO-ului (Local 

Oscillator) V_1Tone, rezistorul  de 50Ohm și masa. 

c. De asemenea, înlocuiți Term1 cu sursa P_1Tone din paleta Sources-Freq Domain și 

setați  parametrii astfel: Freq = 1.9 GHz și puterea P = polar(dbmtow(-40),0).  

Redenumiți  sursa în RF_source. Paramentrul Num trebuie sa fie egal cu 1. 

 

d. Inserați o etichetă cu numele Vout la ieșirea circuitului: 

  -> Insert Wire/Pin Label 

 

Circuitul va arăta astfel: 

 

 

e. Din paleta Sources-Freq Domain inserați OSCwPhNoise și conectați-o cu mixerul. 

Setați parametrii astfel: Freq = 1.8 GHz și adăugați valorile pentru PhaseNoise ca în 

imaginea alăturată. Valoarea implicită pentru putere este în dBm și cu o rezistență de 

ieșire Rout = 50 ohmi. 

 

 -> OSCwPhNoise 
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LAB 4: AC Simulări 

 

Prezentare generală - Acest laborator continuă proiectul amp_1900 și utilizează 

același sub-circuit ca și laboratorul anterior. Acest exercițiu ne învață bazele simulării AC, 

inclusiv a celor mai mici semnale de câștig și zgomot. De asemenea, prezintă multe 

caracteristici detaliate ale afișării datelor pentru controlul și manipularea datelor. 

 

 

 

OBIECTIVE 

 

 Să se efectueze simulări de semnal mic și  zgomot AC. 

 Să se adapteze etichetele pin/fir. 

 Să se schimbe variabilele si să se scrie ecuațiile. 

 Să se verifice schemele, semnele, seturile de date și sursele AC. 
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PROCEDURĂ 

1. Copy & Paste (Ctrl+C / Ctrl+V) de la un model la altul. 

a. Deschideți ultimul proiect(dc_net) și copiați circuitul prezentat aici prin tragerea  

cursorului în apropierea zonei - acest lucru este cunoscut sub numele de rubber banding. Cu 

elementele evidențiate, copiați apoi folosind tastele tastaturii Ctrl + C sau comanda Edit > 

Copy. Utilizarea Ctrl + C este preferată pentru că se elimină clicurile de mouse. 

 

 

 

b. Utilizați comanda File > New Design pentru a crea o nouă schemă și nume 

aceasta: ac_sim. Apoi folosiți Ctrl + V sau utilizați Edit > Paste și inserați  

(imaginea) după copia făcând clic pe noua schemă. 

c. Salvați proiectul ac_sim. Trebuie să o salvați sau nu va fi scrisă în Bază de date. 

d. Faceți clic pe comanda Window > Designs Open. Această comandă vă oferă 

accesul la desene sau modele care sunt deschise în memorie dar care nu sunt vizibile  

într - o fereastră sau nu sunt salvate în memorie. Când apare dialogul, selectați dc_net  

și faceți clic pe OK. Apoi închideți proiectul dc_net folosind File > Close Design (nu 

trebuie să salvați schimbarile). 

e. În fereastra schematică goală, redeschideți ac_sim design folosind comanda File>  

Open Design. Asta vă da o listă a tuturor modelelor din proiect. Dacă un proiect 
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este creat, dar nu este salvat initial, nu va fi in aceasta listă și 

va trebui să utilizați comanda  Window > Designs Open pentru 

al accesa. 

 

        2.Modificați circuitul copiat și etichetele pinilor. 

       Ștergeți firele, introduceți componente noi și reîncărcați după cum este necesar. 

Urmati pasii: 

              a. Deconectați sursa de curent continuu și deplasați-o spre partea laterală cu 

înpamantarea. 

b. Introduceți doi condensatori ideali DC_Block din componentele Lumped-

Components sau utilizați istoricul componentelor. 

        c. Introduceți o sursă V_AC din gama Sources-Freq Domain. Puneți împamantare 

 sursei. Apoi adăugați un rezistor cu sarcina de 50 ohmi și puneti iesirea la masa. 

 

        d. Modificați etichetele Pin / Fir (nod). Faceți clic pe imaginea Nume. 

Adăugați Vcc ca a eticheta atât pentru RC, cât și pentru sursa DC. Acest lucru le va 

conecta electric în loc de un fir.                                                                                                                          

        e. Adăugați Vin și Vout după cum se arată. 
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De asemenea, dacă ați făcut orice pas 

OPȚIONAL din laboratorul 3, eliminați VC și 

VBE dând clic pe aceste etichete atunci când 

dialogul este gol  (afișat aici) sau utilizați 

comanda: Edit >Wire/Pin Label > Remove 

Wire/Pin Label. 

        f. Verificați dacă circuitul arată ca cel prezentat aici. 

         NOTĂ pentru Wire/Pin Label 

Attributes:: Puteți să trageti etichete pentru a le 

muta și puteți edita atributele prin dublu clic pe 

ele sau prin utilizarea comenzii: Edit >Wire/Pin 

Label >Wire/Pin Label Attributes.   

 

3. Intrarea si iesirea din sub-circuit. 

a. Selectați bjt_pkg și PUSH în sub-circuit (imaginile) pentru a verifica  

sub-circuitul dvs., apoi POP ieși din nou.  

4. Configurați o simulare AC cu zgomot 

     a. Introduceți un controler de simulare AC. Apoi  

editați startul, oprirea, startul, oprirea, si pasul 

frecventei: 100 MHz până la 4 GHz în 100 - 100 MHz 

pași. 

            b. În fereastra Zgomot, bifați caseta pentru a 

Calcula zgomotul și adăugați nodul Vout. Setați modul 

de sortare la Sort by Name pentru fiecare contribuitor de 

zgomot. Sortați după Sort by value este bine pentru 

circuitele mari pentru a vedea cei mai mari contribuabili. 

De asemenea, toate valorile zgomotului vor fi simulate 

dacă există o gamă dinamică (pragul) nu este setat. 
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             c. Porniți  Afișarea pentru fiecare din parametrii ca si aici.   

         

            

       5. Simulați și listați datele despre zgomot. 

     a. Simulați (F7).   

     b. În afișajul de date, introduceți o listă 

(imagine) a numelui și vnc (tensiunea 

contribuabili de zgomot) utilizând funcția Ctrl 

pentru a le selecta pe ambele. Așa cum am 

arătat aici, la fiecare frecvență, Q1.BJT1 este 

tensiunea totală a zgomotului pentru dispozitiv 

și este compus din: Q1.BJT1.ibe și 

Q1.BJT1.ice. Cu toate acestea, acestea nu sunt 

correlate dar au fost adăugate caputerile de zgomot: 

(Vtotal) 2 = (Vibe) 2 + (Vice) 2. Total vnc este 

același ca Vout zgomot.  

c. Salvaţi schema şi afişarea datelor.   

 

 

 

 

6. Controlul ecuațiilor de ieșire și al tensiunii de nod 

a. În schema ac_sim, introduceți un MeasEqn din orice paletă de 

simulare. sau, paleta. Sau, puteți introduce în MeasEqn in  istoricul 

componentelor.  

b. Direct de pe schema ecranului, editați (tipul) ecuația de calculat 

amplificarea de tensiune folosind etichetele nodului (pin) Vin și Vout. Utilizați tastatura  
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'tasta sageata' pentru a vă deplasa peste semnul egal (=). 

     

c. Editați controllerul AC simulation 

și mergeți la tabul Output. Valoarea 

implicită pentru etichetele tensiunile 

nodurilor (pin/etichete pe cabluri) și toate 

ecuațiile pentru măsurători sunt raportate în 

dataset. Veți schimba această setare în pașii 

următori. 

d. Debifați pentru Node Voltages și click pe butonul Add/Remove. 

e. Selectați Vin și Vout din lista de ieșiri disponibile și adăugați-le precum este 

evidențiat aici – apoi selectați OK. Doar tensiunile nodurilor vor fi scrise în dataset după 

simulare, Vcc nu va fi afișat acolo. Această metodă funcționează și pentru ecuațiile cu 

măsurători. 

f. Click OK pentru a închide dialogul – puteți efectua simularea acum. 

NOTE pentru afișarea numelui nodurilor: Puteți afișa numele unui nod (Display – bifați 

NodeName), dar nu este necesar. 
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7. Simulați fără zgomot. 

 a. În schemă, dezactivați calculul zgomotului scriind la 

alegere da sau nu, precum este afișat în imagine. Acest lucru va salva 

timp și memorie pentru simulare, în special pentru circuitele mari. 

Bineînțeles, acest lucru va face ca lista dataset să fie invalidă. 

 b. Salvați schema și rulați Simularea (F7). 

 

8. Scrieți ecuația pentru data display folosind o ecuație pentru măsurători. 

 a. În data display, ștergeți valoarea listată invalidă a zgomotului 

 b. Inserați ecuația pentru data display (folosiți iconița).   

 c. În fereastra de dialog, scrieți ecuația pentru câștigul în dB precum este arătat în 

imagini. Observați că în acest timp inserați ecuația pentru măsurători în schemă, apăsați OK 

pentru a continua: 

 

 

NOTE pentru ecuații – Dacă ecuația pentru a măsura câștigul tensiunii nu a fost deja 

calculat, va fi nevoie să scrieți ecuația pentru data display cu toate valorile necesare, de 

exemplu: gain_dB=20*log(mag(Vout)/mag(Vin)). Oricum, deoarece câștigul tensiunii a fost 

deja calculat, este mult mai ușor doar să o inserăm acolo. 
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9. Modul de lucru cu ecuații pentru măsurători și afișare 

 a. Inserați o listă și adăugați ecuația respectivă măsurării gain_voltage și, de asemenea 

adăugați ecuația respectivă afișării datelor, gain dB  precum este ilustrat aici. Ecuațiile 

măsurătorilor schemei sunt scrise automat în datasheet, spre deosebire de ecuațiile datelor pentru 

afișare. Acestea din urmă sunt memorate în memoria destinată datelor pentru afișare și sunt selectate și 

adăugate precum este ilustrat mai jos. Apăsați OK pentru ca ambele ecuații să apară în listă. 

 

 b. Selectați lista și rulați cursorul în jos la 

valoarea de 1900Mhz folosind butoanele pentru derulare 

a listei precum este evidențiat în imaginea alăturată. 

Apoi inserați cursorul direct în antetul coloanei 

pentru gain_voltage după care scrieți în funcția 

dB ca în imagine – asigurați-vă că ați adăugat 

paranteze astfel încât expresia să fie: 

dB(gain_voltage). Aceasta demonstrează 

flexibilitatea datelor destinate afișării pentru 

operare (împreună cu funcțiile ADS) direct în date și ecuații. 

 c. Click pe butonul Undo pentru a șterge funcția dB.  

 d. Editați lista (dublu-click) și schimbați 

setarea Plot Type în rectangular plot  selectând 

iconița reprezentativă. 

e. Inserați un cursor direct în marcajul Y-axis și schimbati gain_voltage în dB(gain_voltage) asemeni cum ați  

procedat mai devreme pentru listă. Apoi reveniți folosind butonul undo. Acest lucru va afișa puterea 

funcțiilor și a datelor pentru afișare.  
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NOTE pentru valorile dB – Transformând voltajul analizei AC în dB nu este la fel ca analiza S-parameter în dB 

care folosește puterea (V și I) și de asemeni are o sursă Z de 50 ohm. 

10. Afișați faza și întârzierea pentru analiza AC a datelor 

 a. Inserați un plot dreptunghiular al fazei Vin și Vout – puneți markere pe 1900Mhz. Faza nu este de 

180 de grade datorită paraziților bjt_pkg. Mutați marker-ul și priviți faza apropiindu-se de 180 la frecvențe 

joase. Ați putea seta o tastă rapidă pentru comanda unui marker nou 

folosind opțiunile DDS Opțiuni – Hot Key. 

 

  

 

b. Inserați o ecuație nouă pentru a calcula group delay. Precum este afișat, folosiți faza lui Vout și funcția diff 

după care afișați ecuația. Funcția diff calculează diferențele între punctele din pantă. Semnul – reprezintă 

descreșterea valorii rezultate. Plasați un marker pe tren 

și observați că se va afla pe oricare parte a frecvenței 

1900Mhz (+/-50Mhz) datorită funcției diff. 

 

 c. Mergeți înapoi în modul schematic, schimbați 

setarea pasului la 10Mhz, rulați simularea din nou și 

priviți graficul ce tocmai s-a modificat. 

 d. Editați markerul (dublu-click pe el). În tab-ul 

Readout, setași formatul la Engineering cu 2 unități precum este 

arătat în imagine. Observați valoarea marker-ului schimbându-se 

în pico (pico-secunde), iar valoarea independentă schimbându-se 

în 1.9Ghz. 

 e. OPȚIONAL – Încercați să grupați întârzierea 

și graficul astfel încât să rămână împreună atunci când 

le mutați. Folosiți tasta SHIFT și selectați graficul și 

ecuația. Apoi selectați Edit-Group. Asta ar trebui să le 

mută împreună în data pentru afișare. 
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11. Informații despre variabile și functia what 

 a. Inserați o nouă listă (datasheet este tot ac_sim). Adăugați Vout, selectați-o, după care click pe 

butonul Trace Option. Puteți face asta într-o pagină nouă sau după ce efectuați un zoom-out pentru a face 

mai mult loc în imagine. 

 b. Atunci când fereastra de dialog apare, click pe butonul 

Variable Info, o nouă fereastra de dialog va apărea precum este 

arătat în imagine. Selectați data Vout și veți vedea că dependența 

pentru Vout este de 391 de puncte de frecvanță. Ar trebui să fie 

asemănător pentru toate articolele din datasheet deoarece doar 

frecvența a fost modificată. 

 c. Închideți fereastra de dialog, click OK, și mergeți apoi 

înapoi în lista Vout. Inserați cursorul în coloana Vout și scrieți în 

funcția what: what (Vout). Observați că veți obține aceleași 

informații variabile. Mai târziu veți folosi această funcție pentru a 

determina cum să indexați în tabelele de date cu sweep-uri multiple . 

 

NOTE pentru funcții: Puteți citi despre funcția what ți celelalte funcții ADS utilizând butonul Functions Help 

oricând veți insera o ecuație în data pentru afișare sau oricând veți merge la Trace Options. Atunci când 

browser-ul Help apare, rulați cursorul în jos la funcția care vă interesează. Încercați și observați cum sunt 

descrise funcțiile ADS. 
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12. OPȚIONAL – Sweep Vcc (ca și cum tensiunea bateriei ar descrește) 

La acest pas va trebui să folosiți abilitățile pe care le-ați obținut în exercițiile din cadrul laboratoarelor 

anterioare. Va trebui să setați un parametru sweep pentru Vcc de la 2 la 5 volți cu un pas de 0.25 volți. 

a. În pagina schematic, inserați VAR ( ecuație 

variabilă) inițializând-o cu Vbias = 5V.   

b. Redefiniți sursa: Vdc = Vbias. 

c. Inserați Parameter Sweep din orice paletă de 

simulări. Apoi setați SweepVar (variabila 

sweep) să fie Vbias. Asigurați-vă că numele 

Instanței Simulării pentru Controllerul de 

simulare AC este afișat acolo. 

d. Schimbați dataset name = ac_bat_swp  și Simulate. Atunci când simularea e completă și DDS se 

deschide, o fereastra de dialog în care va întreba dacă doriți să schimbați dataset-ul – alegeți NU. 

Apoi afișați grafic mag și Vout. Un set de linii pentru fiecare step va apărea, precum este afișat 

mai jos. 

  

e. Pentru a afișa nivelele lui Vbias, 

editați aceste opțiuni folosind 

tab-ul Trace Option și verificați 

în cutia Display Label. 

f. Inserați markere precum doriți. 

Amintiți-vă că puteți insera markerul, iar apoi puteți scrie frecvența dorită – markerul va merge 

automat la valoarea frecvenței. 

g. Salvați tot ce ați lucrat până acum. Puteți păstra fereastra prezentă cu schema – o veți putea 

folosi pentru a începe următorul exercițiu de laborator. Dar închideți display data dacă este încă 

deschisă.  

EXERCIȚII EXTRA: 

1. Într-un nou design, simulați folosind porturile sau zgomotul porturilor. Pentru a face asta, folosiți 

sursa P_AC ca un port 1 de intrare (Num=1) și plasați un Term pe portul 2 folosit pentru ieșire 

(Num=2). Aceste două componente sunt afișate aici împreună cu numerele porturilor. 
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2. Într-un nou design, inserați sursa de curent I_AC și rulați simularea. 

3. Inserați sursa P_AC și urmăriți câștigul puterii. De asemenea, schimbați cu alt parametru si afișați 

rezultatele. 

 

4. Încercați folosind node settings în paleta pentru AC simulation. Puteți seta valorile inițiale ale 

tensiunilor pe noduri folosind funcția Node Set sau refeerindu-se la numele nodurilor folosind 

componenta NodeSetByName. 
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